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Satellite-AV Quick Start Guide

Opening a project

About the Demo Project

The demo project is a 48tk project that contains audio and video to accompany this guide and get you
started with Dream II.

Opening the Demo Project
Launch Dream II.

Press the Project button located on the editor panel of your console.

Fatch

AL Lo

| ——

Project Key

Locate the Demo Project on the audio drive that you chose when you installed it. Using the soft keys,
press {open} to launch the project manager dialogue box.

Select 'Demo.MT”and click OK to open.

The demo project should now be open. This project contains both mono and stereo clips. Mono clips
are contained on tracks 1 to 4. Stereo clips are contained on tracks 5 to 28. Stereo clips occupy two

tracks and are indicated by a coloured link symbol.
Setting up your surface

Patching Main Control Room Monitors

Step 1 Press the Monitor key.
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Fatch

CALL e

. . Monitor Key

Step 2 Press the (Main} soft key in the lower row. This selects the Main speakers (the other Main soft
key selects the Main bus).

Step 3 Press the {pPatch oOutputs} soft key.

Step 4 Press the (Main} soft key again.

Step 5 Press the (Format) soft key to cycle through and select the format of the main speaker set.
Select the type of physical output using the choices on the Channel Select panel of the Mixer
Screen.

Step 6 Select the output for the first speaker using the mouse on the Mixer Screen or the Track Keys

(which currently represent analog outputs).

The bottom right of the Mixer Screen will display your choice, and your stage in the process.
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Step 7 Press the {next} soft key to move to the next speaker in the set, and repeat until all speakers
have been given outputs.
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Step 8 Press the (End} soft key upon completion of patching.

Main bus format

Step 1 Press the BLUE-Format button on the console.

Step 2 Click the Main button on the Mixer screen. The possible main bus formats are displayed on the
LCD screen.
Step 3 Using the soft keys, select the desired format for the main bus.
Step 4 Press the BLUE-Format button again, or any other mode key, to exit the Format menu.
Playing audio

Now its time to play some audio.

Raising Faders
Step 1 Click on a fader in the Mixer Screen, and hold the mouse down.

The mouse jumps down (if the fader is closed) near the bottom of the screen.
F D e —| JUl;ll;lEl:-f =1

Track 3 | Track 4 | Track 5

Click on fader and

drag it to change
—  level

| Track 19 | Track 20 | Track 21

B - .
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Step 2

Drag the mouse upwards, and you'll see the fader rise as well, but slowly.
The mouse is “geared” high so that you can set fader values accurately.

Look at the “Fat Channel” below. The channel you clicked has been “called” to the Fat Channel,
and the fader mirrors the movements you are making. You can also see an accurate numerical
fader value.

It’s also possible to set multiple faders at the same time:

Step 1
Step 2

Step 3

Click on the numbers of several channels. They will go red — this is called a Multi-Trim group.

Click and drag the fader of a channel whose number is selected, and all Multi-Trim faders will
move relatively i.e. by the same percentage. You can also force them all to have the same value
by control-dragging one of the faders — the others will instantly adopt the same value.

You can add or subtract members from the Multi-Trim group at any time. While it is active you
can also change fader levels for other individual channels that are not in this group.

NOTE: Multi-trim can be used with all the controls on the Mixer Screen e.g. Mute, Solo, EQ in, Insert.
Click to toggle all the channels, or Ctrl-click to set them all the same.

Set fader to unity

Step 1

Double-click the Master fader. This will set it to unity (0 dB). The same applies to any other
fader.

Control Monitor Level

Step 1

Step 2
Step 3

Press the Monitor key.
The Jogger Wheel now controls the Monitor volume.

In addition, the Monitoring section is shown in the Fat Channel at the bottom of the Mixer
Screen. You can use the mouse to change its fader level.

Set the Monitor level low, and unmute the monitors using the (Mute} soft key.

Press Play on the transport and slowly turn up the monitor control level pot. You should be able
to hear the demo song playing back.

After selecting desired monitoring level, press “Monitor” key again to exit monitor level mode.

The demo project also contains a video track which is displayed as the first track in Dream II. (Note: the
video track is separate from track feeds, and does not replace Track 1).

To view the video, open View > Pyxis from the toolbar on your Dream II Editor screen. You should now
be able to view the video as well as hear audio. (Note: you need to obtain a Pyxis license if you want to
enable this feature).

Transport

The Play, Stop, FF, and Rew controls work in a similar manner to a tape machine. You can also
increase the fast-forward and rewind speeds by pressing their buttons again, up to six times.
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Shuttle

To shuttle the transport, hold down the BLUE key and press Jog/Shut. The jogger wheel will then
increase and decrease the transport velocity in forward and reverse.

If you hold down the BLUE key and press Jog/Shut while the transport is in Play, the system will enter
Shuttle at play speed.

If you press the REW key while shuttling forward, the system will reverse direction, maintaining the same
speed. Similarly if you press the FF key while shuttling backwards, the system will shuttle forwards at the
same speed.

Jump

The Jump keys provide a fast method of locating forwards and backwards through a project. The Jump
keys are located on the Binnacle, left and right of the Play/Jog key.

Mouse

Holding down the right mouse key and moving the mousewill also move the transport, but no sound will
be heard.

Locator Functions

Rapid navigation through the project is achieved by making marks on the time-line. To create a mark,
locate the transport to the desired point and press the Mark button. Marks are shown as yellow
indicators on the timescale in the Dream II Editor display.

Fatch

CALL e

Marks can be named, or moved by entering a timecode. To do this:

Step 1 Create a mark using the Mark button on the console.

Step 2 Press BLUE-Mark, or select View>Locators in the Edit Screen. The Edit Marks dialog is shown:
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Mame | Time
01:00:04:10
/ 01:00:10:20
/ Click Rename
Click on the
mark you want
to name
Step 3 To name a mark, select it, then click the Rename button and fill in your desired name.

Step 4 Press ENTER.

Track Display

Select the number of tracks to display on the Dream II Editor display by holding down the BLUE key, and
pressing one of the numeric keys labelled 1T, 2T, 4T, 8T, 16T, 24T, 32T and 48T.

.
_.1
T Track Display
Keys
1 B
T =T

Zoom
To zoom:
Step 1 Hold down the Zoom Binnacle key.

Step 2 Turn the jogger wheel to zoom in and out.

If your mouse has a wheel, it can also be used to zoom in and out.
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Grouping

Link groups allow the control of up to eight feeds with one fader. (A “feed” is a Track Feed or a Live
Feed, controlled by the buttons above the LCD soft key buttons). When a link group is created, the
number of members determines the format of the link group.

For example, to create a stereo link group on tracks 5 & 6:

Step 1 Press the Group key

Group

Step 2 Press the selection key of the first feed of the group (track 5).
Step 3 Press the selection key of the last feed of the group (track 6).
Step 4 Select the {a11 defaults} soft key.

This will apply pan settings to each member of the link group in the specified format (in this case, L & R).
For example, if tracks 1 to 6 were linked they would be panned L: C: R: LS: RS: B.

All defaults also applies the track feed parameter values of the first member of the group to all the
members (these are fader level, pan, EQ, dynamics, aux sends, inserts and direct out state).

Step 5 Press the Group key again, or any other mode key (Cut, Copy etc), to complete the operation.

To destroy a link group:
Step 1 Press the Group key. The feeds that currently belong to a link group flash red.
Step 2 Press the feed selection key of a feed belonging to a group.
Step 3 Select {unlink} in the LCD soft key menu.

Step 4 Press the Group key again, or any other mode key (Cut, Copy etc), to complete the operation.

Tracks in Link Groups are always selected together, by selecting any one of them.

Mixing Functions

All Satellite mixing functions use the mouse. A group of these functions can be controlled directly on the
Mixer Screen, as shown below.
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Dynamics In (indicator only — appears

Click here to when any dynamics present)

cycle the
display

Eggﬁgnﬁnr Track 5 | Track 6 ack_#7 I
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/
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Solo ON / OFF
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to the Multi- = El |I|

Trim group (the

number goes Track 21 | Track 22 | Tr

-l- - Fader Control
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EQ IN / OUT
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m
[

on i

m
-

Compressor || B Gate/Exp Limiter

e To open the DREAM II Virtual Channel, right click on a channel “tile” in the Mixing Screen. In the
above example, we have right clicked Track 8.

e To close the Virtual Channel, right click anywhere inside it.

e While it is open, you may move to the next or previous channel by clicking the + and — buttons
next to the channel name.
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[+

Click to select next or |:|
previous channel —>

Panning

Dream II supported surround formats are: Stereo; LCRS, LCRSS; 5.1; 6.1; and 7.1.

Panning IN / OUT

e ' ' Boom send ON /
In Hre @1 OFF

While operating the pan controls, the Fat Channel gives a visual representation of the pan position and
divergence. A complex example is shown below.

]
#
g
|
¥

Baom

L L= s Rz R

Panning of 4-way Link Group
showing Rotation and
Divergence

LS —rtr  Crotr S
=

FPAMN

Basic Panning

Use the L-R and F-B controls for basic panning. If the Main Bus format does not have surround channels,
the F-B control will still be shown, but will do nothing.

Spread

Only available when a link group is selected. The spread control adjusts the perceived size of a surround
mix.
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Diverge

Spreads the signal of an individual feed across more of the adjacent loudspeakers, making the perceived
size of the sound source larger.

Rotate

Rotate controls the left/right and front/back pan control to rotate the surround mix around the centre of
the room.

Using the panner:
Step 1 Call a signal path to the channel panel by pressing the Call button on any fader.

Step 2 Adjust the control to achieve the desired result. The parameter values are displayed in the fat
channel section at the bottom of the mixer display.

Boom

Sending level to the Boom channel can be done pre or post fader.

Satellite-AV Page 15



Quickstart Guide SATELLITE-AV QUICK START GUIDE April 5, 2007

Equalisation

Lo-Pass Filter

" .

- Parametric EQ
(bandpass)

- Hi-Pass Filter
EQ IN/ OUT

Maszter

Gain Compensation

The track feed mixer EQ provides four bands of parametric equalization and two filters. Each parametric
section can be switched in or out independently.

The Gain controls in the Filter sections have no function. The 2X controls double the slope of the filters,
from 12 to 24 dB / octave.

Dynamics

The Dream II Dynamics comprises three sections, compressor, limiter, and expander or gate.
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Make-up gain

Limiter IN / OUT

Gate/Expander IN / OUT

LImitet

Compressor IN / OUT

Each section has an independent IN / OUT control. All three may be active at the same time if required.

The Fat Channel shows the transfer function of the dynamics control, plus gain reduction metering.
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AN
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Aux Sends

Satellite-AV provides 12 aux sends. Each send from each channel has an independent Pre/Post switch
and In/Out control.

Aux 2 send IN / OUT

Satellite-AV Page 19



Quickstart Guide SATELLITE-AV QUICK START GUIDE April 5, 2007

Mix Automation

Track 9

l_l__| =5 \ O rr_‘ B

|i|il; l; u : Faders in READ
| I — I

.— P — || _
l_l_ l_l_ l_l_ l_l_ =]

Fader in WRITE

&
l_ 1] l_ 11} l_ 11} I_ 14} B
Ell ] &5 (42E] ] 5|43l 5 [44E] L B I_I__ E |

AL AL AL Avtomation [#] Enable

2 3 4

on
Stop | Touch | Record Enables

[Fede]
Lakch | Trirn ] | Ttz l |Cnmp]
fetur]
Touch Auto Enable

To automate mixer data, do the following:

Step 1 Enable Automation
Click the Enable button at the top of the section
Step 2 Enable Parameters

Click any of the buttons in the Enables section. Only the enabled parameters will write data. In
the above picture, Faders are enabled.

Step 3a Enable Signal Paths — Method 1
Set Touch to either Latch or Snap

Select the Mix menu button on the Satellite console, and select a track to automate. When you
touch that Track’s controls, it will go into write (or trim)

Step 3a Enable Signal Paths — Method 2

Set Touch to either Latch or Snap
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Step 4

Step 5

Step 6
Step 7

Switch on Touch Auto Enable, using its checkbox

When you touch the controls on any signal path, it will go into write (or trim)
On Stop Setting

This can be set on the screen or using the On Stop soft key in the Mix Menu.

If {on stop Hold} is selected, all the following mix events are deleted, so the last written value
remains in force for the rest of the project.

If {on stop Return) is selected, the parameter ramps to the previously recorded value over the
Glide Out time (Glide Out time is set in the Utils Menu).

If {on stop Event} is selected, the last written value remains in force until a previously
recorded event is encountered. At this point the parameter value ramps to the new value over
the Glide Out time.

Record Setting
Select WRITE or TRIM
WRITE: New values are written for enabled parameters, replacing the previous values.

TRIM: In trim mode, moving a control applies an offset to the values already recorded for that
mix item. For example, in trim mode, increasing a fader level by 10dB will add 10dB to the
previously recorded fader levels retaining all the relative changes in the previously recorded data.

Put the transport into Play (or Record)
Move the enabled controls. Stop to cease recording automation data.

The data will be written to the automation file. When you play back over this section, the moves
you made will be shown in the controls.

Editing Basics

Cut and Paste Editing

The edit modes are selected on the outer ring of the binnacle keys. These modes are cut, copy, erase,
trim / slip, and fade. To perform cut and paste editing.

Step 1

Step 2
Step 3
Step 4

Select one or more tracks using the channel selection keys. Selected track numbers are
highlighted in blue on the Dream II Editor screen.

Press the Cut key on the binnacle to enter Cut mode.
Make sure the Range ON key is OFF.

Locate the transport so the cursor lies over the desired edit point. Clips that are selected for
editing are pink. Unselected clips are blue.
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Step 5

Step 6

Step 7

Press down an “edit target” key (Clip, Head or Tail) on the left hand side of the binnacle. The
thing you pressed is cut and placed on the clipboard.

Locate the transport so the cursor lies over the destination edit point. If required, select
alternative destination tracks using the track selection keys.

Press the ENTER key to paste the clip(s) on the clipboard.

Copy and paste is the same, except you select the Copy mode key on the Binnacle.

Using a range, you can cut and paste regions in the middle of clips. The method is similar — you must
create your range (see later), and you must press the Range target key. Ranges are discussed later.

Trimming Clips

Trimming a clip means exposing more or less of the original recording in that clip.

Step 1 Select one or more tracks using the channel selection keys. Selected track numbers are
highlighted in blue on the Dream II Editor screen.
Step 2 Press the Trim key on the binnacle to enter Trim mode.
Step 3 Press the Head or Tail target key. This shortens the clip to the current transport position.
Step 4 If you want to refine the trim position further, move the transport to the position where you want
the clip to end, and press ENTER.
Super Trim

This allows you to see and hear the full extent of the clip while trimming it.

Step 1

Step 2
Step 3
Step 4

As before — select one or more tracks using the channel selection keys. Selected track numbers
are highlighted in blue on the Dream II Editor screen.

As before — press the Trim key on the binnacle to enter Trim mode.
Hold Down the Head or Tail target key. This lengthens the clip to its full extent.

While continuing to hold down the key, move the transport to the position where you would like
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the clip to end.
Step 5 Release the target key, and the clip will be trimmed to the current transport position.
Fades
Simple Fades
To create a simple fade:
Step 1 Select a track and move a clip under the cursor.
Step 2 Press the Binnacle Fade button.
Step 3 Make sure there is no range (press the Range ON button if illuminated).

Step 4 Press the Head button.

This will create a fade from the start of the clip to the cursor position. The shape of the fade will follow
the graph shown in the Head region of the Fade display, shown below.

00:00:00:29

o0:00:00: 10

Head Duration value

00:00:00: 10

You can change the shape by dragging the red Crossover indicator with the mouse, then reapplying the
fade. You can also enter the shape values numerically by clicking in their fields.

Pressing Tail in step 4 would create a fade from the cursor to the end of the clip.

Pressing Clip in step 4 would apply the numerical Duration values to both ends of the clip (see Advanced
Fades below).

Advanced Fades

In the Simple Fades section above, the length of the fade was determined by the clip’s position relative to
the cursor.

In Advanced Fades we will set the lengths of fades numerically.

Fade lengths are set numerically when:
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Fade Clip is used (press the Clip button instead of Head or Tail)

There is a range (press Head, Tail or Clip). The results are applied to all clips that are wholly within the
range.

When the Set Dur or Trim Dur commands are used.

Choosing What is Set

In all fade commands, you can choose to set only the fade length (uncheck Shape) or only the shape
(uncheck Length). By default both boxes are checked.

- The Clip, Head and Tail buttons do the
Clip Head Tail [®— same as their Binnacle equivalents
Sek —Cration — | Trim
Delete Capkure
v Length < v shape Length and Shape checkboxes

Setting Fade Duration Numerically
Step 1 Press the {set dur} soft key.
Step 2 Choose Head, Tail or Clip to determine which end(s) of the clip is being affected.
Step 3 Use the jogger wheel or Numeric Keypad to enter a fade length.
Step 4 Press ENTER to apply the fade. If Shape is checked, it will also be applied.

If a range is present, this command will apply to all clips that are wholly within the range.

Trimming Fade Duration

Press the (trim dur) soft key and use the jogger wheel to enter a positive or negative value. Deselect
the {shape} soft key if you do not wish to apply the current fade shape to the selected clips.

Press the Binnacle Clip, Head or Tail key to increase or decrease the length of fades by the specified
amount. Pressing the Clip key affects fades at both the Head and Tail of each selected (pink) clip, while
pressing Head affects only fades at the head and Tail affects only fades at the tail.

Step 1 Press the {trim dur) soft key
Step 2 Choose Head, Tail or Clip to determine which end(s) of the clip is being affected.
Step 3 Use the jogger wheel or Numeric Keypad to enter a fade length trim.

This will be shown as <+ something> or <— something> in the display.

Step 4 Press ENTER to apply the trim. If Shape is checked, it will also be applied.

If a range is present, this command will apply to all clips that are wholly within the range.
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Adjusting Fade Shape

Press the {x-Level} soft key and use the jogger wheel to adjust the X-Level and/or press the {x-
point} soft key and use the jogger wheel to adjust the X-Point. You can also change the values
numerically on the screen, or by dragging the red crossover point with the mouse.

The shape is used whenever a fade is applied, if the Shape box is checked.

Capturing Fade Shapes

Press the {capture} soft key plus the Binnacle Clip, Head or Tail key to capture the fade shape from
the current clip. The current clip is the clip currently touching the playhead on the active track.

Deleting Fades

Press the {delete} soft key, then press the Binnacle Clip, Head or Tail key to delete one or both ends
of the fades.

Presets

A preset is a saved shape for head and tail. Factory presets are provided for your use. Custom presets
are saved by you.

To load a factory preset, press the {preset} soft key, then press keys 1-9 on the numeric keypad to
choose one of the 9 factory fade presets. The preset is loaded into the Shape graphs, and can be applied
to clips in the usual way. Alternatively, click a number in the preset pad at the left of the display.

010 20 20 40 &0 k0

.1 |Head
1 2 3
k!
4 = ‘1 & " Click to load a factory preset
718 (|9 |
Fade Presets 15
20
BN

To load a custom preset:
Step 1 Press the {preset} soft key
Step 2 Press {custom preset}.

Step 3 Turn the Jogger Wheel, and as each custom preset is displayed it is also loaded. Stop when you
have loaded the one you want.

Alternatively use the custom presets pulldown menu in the Fades display.
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- P k
{zad Tail disiots
I 3 Click to load a custom preset
iration — | Trim
Save
Capture Click to type a new name for a
v sh ape Delete custom preset, then click Save
To save a custom preset:
Step 1 Set up the fade shapes you want to save.
Step 2 Press the {preset} soft key
Step 3 Press {save preset}.
Step 4 Type a name for the new custom preset and press the Binnacle Enter key.

Alternatively use the custom presets pulldown menu in the Fades display, as shown above.

About Range

A range allows a group of clips across one or multiple tracks to be selected. Range may be turned on or
off using the Range ON key, to the right of the Binnacle. Double pressing a Binnacle edit key always
clears the range.

To select a Range:

Step 1 Locate to the time at which you wish to start the range.
Step 2 Press the From key located on the left of the jogger wheel
Step 3 Locate to the time at which you wish to end the range.

Step 4 Press the To key located on the right of the jogger wheel.

** Note: You can also select or deselect clips by CTRL-Clicking them with the mouse. If you CTRL-Click a
clip outside the current Range, the range boundaries are extended.
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Clip-Based Equalisation
The Dream II console provides both track EQ in the mixer, and clip based EQ in the editor.
Applying Clip Based EQ

Clip EQ provides clip based, four band parametric equalization which can be applied to a single clip or
range of clips within a project.

To apply clip based EQ:
Step 1 Select the track that contains the target clip for equalization.
Step 2 Move the target clip under the play head so that it goes pink.

Step 3 Press the EQ button located on the editor panel. The Smartpane on the Dream II screen will
now appear.
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5

EQ key

Step 4 Press the (Edit} soft key.
Step 5 Select the appropriate EQ parameters and set their values.
Step 7 Click on the {o1d/new} soft keys if you want compare your new settings with the current setting
for the clip.
Step 8 Press the (app1y} soft key or the Binnacle Enter key to apply the fade.
EQ In/Out

Click on the {in/out} soft key at any time to toggle clip equalization on and off for the red clip(s).

Copy EQ Between Clips

Click on the {in/out} soft key at any time to toggle clip equalization on and off for the red clip(s).

Step 1
Step 2
Step 3
Step 4
Step 5

Select the track that contains the clip to be copied.

Move the target clip under the play head so that it goes pink.

Press the {copy} soft key

Locate the target clip under the cursor so that it goes pink.

Press the {apply} soft key to paste the EQ values into the new clip

You can uncheck some of the bands if you don't want to paste them (see below)

\/_w IR R
-2

10K Band Fraq Gain o] After Cop
r Yy —
20 HF| | 907 Graph is red

—
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EQ With the Mouse

All the EQ controls are duplicated on the screen, and can be operated with the mouse.

Band Fraq Gain o s -
n resats
E%| wono | 00| 1o =l == iy | -
HIMF | @soo | oo 1o =R
|ﬂ|| ez | 132 | 1o =WV o Save
I_LFHE“ a0 I 0.0 I 1.0 =l New 0= Delete

In addition, the graph can be directly manipulated by dragging the red control points around the screen.
This will update the Gain and Frequency fields (and cause changes in the sound). Q values can only be
changed numerically.

20 =) 100 200 =il 1K 2k Bk 10k
20 B Drag red dots
10 S > with the mouse
o u o s to change gain
-1 and frequency
0 values.
VST Plugins
Setup and installation
Step 1 Install your plugins as outlined by your plugin manufacturer. The plugin will generate a file with

extension ‘DLL’ in the folder that your plugin has been installed (most commonly located in
C:\Program Files\VSTPlugins).

Step 2 Copy the DLL file and paste into C:\Program Files\Fairlight\Dream II\Effects\VSTPlugins.
Step 3 Restart the Dream II PC.
Inserting a Plugin on a Feed

Step 1 Call the Track or Live Feed using the Call menu, or by clicking it on the screen.

Step 2 Press the Insert menu key in the upper left of the console.
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/ Insert key

Step 3 Press the {add plug-in} soft key. Using the jog wheel, scroll through the list of plug-ins.

Step 4 When the desired plugin is displayed, press Enter. The plugin popup will now appear on the
Dream II Editor display.

Step 6 To remove the plugin, press the {Remove Plugin} soft key.

Rewire

Launching a Rewire Application

In order to patch a Rewire device, a Rewire application must be installed first (e.g. Reason, Ableton Live).

Step 1 Click Setup>Instruments in the Dream II toolbar to launch the dialogue box. Your Rewire
application should appear in this list.

Step 2 Click on the name of the desired Rewire application so it is highlighted.
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Instrument | MIDI Device | MIDICharnel |

Ableton Live

Reason Adapted

[ [ oo |

Step 3

Step 4

Click on ‘Edit’ at the bottom of the dialogue box. Note: Some programs (eg — Reason) will launch
automatically. Others (eg - Ableton Live) need to be launched manually.

Open or create a project within your Rewire application (demo projects that accompany the
application are a good starting point).

Patching a Rewire Application

Once your Rewire Application is launched, it's time to patch Rewire inputs to track or live feeds.

Step 1

Step 2
Step 3
Step 4

Open the Patch I/0 page by pressing the Patch I/0 key on the channel panel. Click on
Instrument Inputs located on the left hand side of the Patch I/O page. You see inputs labeled
according to the Rewire applications you have installed. If you have installed more than one
application, click ‘Page Down’ on the patch I/O page until you find the input for your Rewire
application. Select the desired instrument input (e.g. If using Reason, select the inputs labeled
Mix L and Mix R for a stereo mix).

Select Live Inputs located on the right hand side of the Patch 1/O page.
Select Live Inputs 1 and 2.

Click Patch to complete the patch.
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You should now be able to hear a stereo signal generated by your Rewire application on Live
feeds 1 and

Step 5 Alternatively, you can patch instrument inputs to track feeds, but make sure the track is record
enabled in order to hear your Rewire device (see Part 11 - Recording).

Recording

To record audio on a track, you must have an input patched to it. This could be any signal source —
this case we will use an analog input.

Step 1 Press the Patch I/0 button on your console.
Step 2 Click on Analog Inputs located on the left hand side of the patch I/0 page.
Step 3 Select four of the analog inputs.

Step 4 Select Track Inputs located on the bottom right hand side of the patch I/O page. Select four
tracks.

Step 5 Click the Patch button to connect the four inputs to the four tracks.

Step 6 Select the Arm key located on the editor panel. The channel selection keys will now display red.
NOTE: A track with no input patched cannot be Armed.
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Press the Arm
key followed by a
channel select
button to arm

tracks

Step 6 Press the channel selection keys of the same four tracks. They are now armed for recording.
This is indicated by the red record enable indicators located on each track in the Dream II editor
display.

Step 7 Locate the transport to where you want to start recording, then press Play and Record
together.

Step 8 The recorded tracks will display red while recording.

Step 9 Press Stop to cease recording.

The Record Menu

Some advanced recording functions can be accessed by holding down the Record button and choosing
from the LCD Menu options:

{head) Starts recording at the head of the clip under the cursor on the current (last-selected) track. If
there is no clip under the cursor, starts at the next clip in a forwards direction.

{clip} Same as {head} but recording drops out at the tail of the clip, so it covers the exact duration of
that clip.

{here} Recording starts exactly where the transport is located, but first it will preroll (see later). This
allows you to find the exact punch-in point and the system will automatically punch in for you.

{again) Repeats exactly the same recording you just made, dropping in and out where the last
recording did.

Preroll and Postroll are used in all the Record Menu functions. They are set on the ADR Menu:

Step 1 Press the ADR button on your console.
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The screen displays a dialog box.

Statt | End | Dislogue | Hide:

[~ Language
[~ Show Streamer
[~ Countdown

Il Loop
Pre-Rec | 00:00:00;00
Preroll 00:00:03:00

Postroll | 00:00:00:29

Delete

Delete Al

10 EEL

Impork

Rehearse Early In PreRoll From Add Cue Prew Cue
ZYCLE STCP

RecPlayback Keep Playing Rec Qut To Edit Cue

Mexk Cue

Step 2 Click in the Preroll field at the right of the dialog and set a convenient value.

Step 3 Click in the Postroll field and set a convenient value.
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